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1. INTRODUCTION

Thank you for choosing an Astro-Med data acquisition recorder. This Quick Start Guide was prepared to let you get acquainted with
your recorder as quickly as possible. We even include a sample exercise so you can become familiar with the basic operation.

This Quick Start Guide supportstwo models: The Dash 8Xe and the Dash 8X.
Throughout this guide, both models will be referred to as Dash 8Xe/ Dash 8X.

The Dash 8Xe/ Dash 8X is a powerful and versatile data acquisition recording system that provides the capability to display, record,
and review waveform data. The system uses up to eight plug-in modules for signal input connections. Input modules are installed
using the eight plug-in slots, which provide configuration flexibility for avariety of applications and future growth.

Data samples from up to eighteen signals can be acquired at rates up to 100,000 samples per second per channel and streamed directly
to a high-capacity hard drive. Each channel can be independently set up to trigger a capture.

Data samples from up to eight signals can be acquired at rates up to 200,000 samples per second and streamed directly to

a high-capacity hard drive. Additionally, the Dash 8Xe/ Dash 8X has a scope card option that adds four channels with sample rates of
up to ten million samples per second.

The Dash 8Xe/ Dash 8X utilizes atouch-screen as the main user interface. Many of the Dash 8Xe/ Dash 8X control buttons are
customizable, providing the capability to modify the display based on the needs of the user or application.

2. GETTING STARTED
Voltage Verification: The Dash 8Xe/ Dash 8X has an auto-sensing power supply that operatesfrom 102 —264 VAC at 50 or 60 Hz.
Y ou do not have to set up any fuse block arrangement.
Connect AC Power Cord: Connect AC power cord to the side panel, then to an outlet.

Turn On Dash 8Xe/ Dash 8X: When you turn on the Dash 8Xe/ Dash 8X, the display will show various initialization screens and
then load in the last setup it had before it was powered down.

Signal Inputs. The Dash 8Xe/ Dash 8X can record up to eight channels of analog signals. Signal type is dependent upon the signal
modul e used for each channel.

Display: The Dash 8Xe/ Dash 8X has alarge touchscreen display. The display is divided into two main areas, the Waveform Display
Area (shows the waveform signals typically drawn onto a grid pattern) and the Control Panel (rows of control buttons for operation).

3. HARDWARE OVERVIEW

Thefollowing is a summary of the location of the physical components of the Dash 8Xe/ Dash 8X.

Front View: Touch Screen, Carry Handle

Right Side View: Signal Modules (up to eight signal modules), Computer connections (parallel port, serial port, USB port,
Ethernet port, Mouse port, Keyboard port, VGA port)

Left Side View: Power indicator light, Power switch, Power inlet, Scope card (optional), Utility port, Recorder port
(model SCR-8), Link ports, Event port, DC Input
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4. MENUS & BUTTONS
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Dash 8Xe/ Dash 8X screen highlighting the Menu Bar and Control Panel

The menu bar is a group of drop-down menus located across the top of the display.
All Dash 8Xe/ Dash 8X modes and features can be accessed from this menu. Options available from
the menu bar will vary based on the mode of operation (Realtime, Scope, or Review) used.

If the date and time are visible instead of the menu bar, choose the M button in the upper right hand
corner, which toggles the display of date/time and menu bar.

Cursorz - Capture - Service - Chart - Help | |
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CONTROL PANEL

The File menu is used to save and load your setup files.

The Configuration menu is used to select the operation of the Dash 8Xe / Dash 8X.

The View menu is used to supplement the graph display of your signals.

The Setup menu is used to configure the Dash 8Xe/ Dash 8X.

The Cursors menu is used for time and amplitude measurements.

The Capture menu is used to setup, arm, manual trigger, and abort data captures.

The Service menu isfor less frequently used parameters such as calibration and security settings.
The Chart menu provides for operation of the optional SCR-8 thermal recorder.

The Help menu provides for on-line assistance.

The control panel isan array of icon-based buttons located on the right hand side of the display. The
icon buttons allow for a single touch to execute afunction. The Dash 8Xe/ Dash 8X ships with the
control panel displaying icon buttons for speed control, analog set up, meter mode, and run/halt.

The control panel can be customized to add or remove icon buttons to suit your recording needs.
Further, the control panel settings can be saved to afile for later recall making test preparation very

easy.



Commonly Used Buttons

The following buttons are commonly used in Dash 8Xe / Dash 8X windows:

B

OK saves the information you entered in awindow and then closes the window.

E

Exit cancels the action you were performing in awindow and
closes the window without saving any changes.

E

s 1<

Apply saves the information you modified in awindow without closing the window.

E

Select All selectghighlights all itemsin alist box.

Clear Selection removes the selectionghighlights from all itemsin alist box.

E

E

3'.,,‘, I
2 & B

v,

Copy copies the selected items (or characteristics of selected items) to the clipboard.

Paste pastes the clipboard contents to the selected location.

Save saves current configurationsto afile on your disk.

L oad loads configurations from afile on your disk.

E

Y



5. USING THE Dash 8Xe/ Dash 8X
The Dash 8Xe/ Dash 8X has three modes of operation, Realtime, Scope, and Review modes.

Realtime M ode: Realtime mode provides real-time waveform scrolling, monitoring, and data capture capabilities. Additionaly,
almost all system setup options are accessible from Realtime mode.

Scope M ode: Scope mode acts like a digital storage oscilloscope, providing high time-base resolution for viewing high-
frequency signals. If the optional DSO-8 scope card is installed, high-speed scope captures up to ten million samples per
second can be acquired using Card mode.

Review Mode: Review mode provides the capability to review and analyze saved data captures and scope captures.

Help: Within the Dash 8Xe/ Dash 8X, three forms of help are available:

Button Help The button help feature provides on-screen help for the buttons.
A brief description is of the selected button is provided.

Context Help The context help feature provides context sensitive, on-screen help. @ I
ﬁ

Online Manual The Adobe Portable Document Format (PDF) version of the manual is
available for on-screen viewing.

6. SETTING UP THE DISPLAY APPEARANCE

The Dash 8Xe/ Dash 8X gives you total control over chart layout. Y ou can set individual channel widths, channel location, grids
ON/OFF, and major/minor division sizing. Y ou are also able to suppress or enable waveform display as well as vary the waveform
trace thickness. Further, you can overlap some or al of the channels.

Basic Channel Views: The Dash 8Xe/ Dash 8X provides basic channel views that you can access from the menu bar. These views
allow you to choose a fixed number of channelsto display. In Realtime mode, choices are Basic 2, 4, or All channels. In Scope or
Review mode, choose from 1, 2, 4, or All channels.

Custom Channel Views: If you don't find aview from the Basic Channel Views described above, you can use the
Chart / Display wizard. The wizard alows you to pick the number of channelsto display. Y ou can further customize your chart by
overlapping or resizing the channels. Y ou can also add, remove, or replace channels.

7. AMPLIFIER SETTINGS

For each channel of the Dash 8Xe/ Dash 8X, aunique signal input module isinstalled in the right side of the recorder (example:
IHV1). Each channel has unique amplifier settings. It addition to setting the span for the channel, you can aso adjust the zero volt
position. For convenience, amplifier settings can be copied to other channels, when the channel s share the same type of signal input
module. Further, user scaling is supported so that your channels can report their values to you in Engineering Units.



8. SAMPLE EXERCISE
9Volt Battery Test
Items needed: 9 Volt battery. Signal input leads.

In the following hands-on exercise, you will set up a channel to monitor a9 Volt battery in realtime. Next, a data capture will be set
up to record when the battery voltage is applied. Finaly, the captured datawill be reviewed.

Note: The steps below are for the NDV1 or IHV1 voltage modulesinstalled in Slot 1 (Channel 1).
Please contact Astro-Med if you have any questions regarding the use of other modules.

In the exercise, every action needed is detailed in a step-by-step fashion to help you quickly become familiar with the operation of the

Dash 8Xe/ Dash 8X. The ACTION on theleft-hand side describes what isto bedone.  The HOW TO section provides the detailed
steps to take using the pull-down menus of the Menu Bar.

|. Real-time Monitoring:  Monitor the voltage of a9 Volt battery.

Set up the channel so that when thereis no signal, the waveform trace will be at the center of the channel and when the
9 Volt signal is applied, the waveform trace will be near the top of the channel.

ACTION HOW TO (Usethe Menu Bar Pull-Down menus)

Verify Menu Bar display If the date and time are shown at the top of the screen, pressthe M icon in the
upper right hand corner to show the Menu Bar.

File - Configuration - “iews - Setup - Curgors - Capture - Service - Chart - Help | |

Dash 8Xe/ Dash 8X Menu Bar

Default the Choose Configuration >> Utilities from the menu bar to open the Utilities
Dash 8Xe/ Dash 8X window.

Choose Defaults >> System from the menu bar to set the recorder to factory

defaullts.

Click Yesto accept.
Enter Realtime Mode Choose Configuration >> Realtime from the menu bar to enter Realtime Mode.
View All Channels Choose View >> Basic All Channels from the menu bar.
Set speed to 5 mm/sec Press the [5 mm/s] button on the control panel. 5

mm{s
Continued...
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Analog Channel Setup

Physical Input Filter Result
Set Channel #1 to be s DT wactom 1 |

20 Volts Full Scale

Result Label

Waveform 1 5.00000 0.00000 Volts
Waveform 2 5.0000 0.0000 Volts
Waveform 3 5.0000 0.0000 Volts
Waveform 4 5.0000 0.0000 Volts
Waveform 5 5.0000 0.0000 Volts
Waveform 6 5.0000 0.0000 Volts
Waveform 7 5.0000 0.0000 Volts
Waveform 8 5.0000 0.0000 Volts

Low
Alarm

EE
Sl 2] X o

Dash 8Xe/ Dash 8X Amplifier Channel Settings Window

Choose Setup >> Amplifier Channel Settings from the menu bar.
Highlight Waveform 1.

Span Adjustment

Span adjustment keypad

Press the Span column. Pressthe digit “2” and “0" to select twenty. Press OK.

Input battery voltage into Use the banana jack input connection located on the side of
Channel #1 the Dash 8Xe/ Dash 8X and input the battery voltage into Channel #1.

Measure the battery voltage Choose View >> Meter from the menu bar to activate the Meter Mode.
using the color display Observe the battery voltage.
Choose View >> Meter from the menu bar to remove the meter.

Remove battery voltage.

This completes the first part of the exercise, Realtime Monitoring.



I1. Data Capture Settings:

Set up asingle data capture for 10 seconds. Of the total capture time, two seconds of the capture should show what the
signal looked like before the battery voltage was applied. The sample rate will be 1,000 samples per second.

ACTION
Enter data capture setup

Select capture of
Channel 1
Set sample rateto 1 kHz

Set capture for 10 seconds

Set trigger point at 20%

Verify time of capture

Set capture for one record

Save and exit data capture
setup

Capture Setup

Base Filename DCR

Waveform 1 Standard

Waveform 2 Standard
Waveform 3 Standard
Waveform 4 Standard
Waveform 5 Standard
Waveform 6 Standard
Waveform 7 Standard
Waveform 8 Standard
Events Standard

Storage Allocation

ml Percent Pre-Trigger
I. No Trigger

1000

Sample Rates [Hz)

i ,000 hd| Standard Rate

Record Duration: 00:00:10.00
Pre-Trigger Duration: 00:00:02.0000
Total Number of Samples: 90,000
KS{Channel: 10.000

C:AD82\Data Capture Files

I. Auto Review

‘$
IRIG Event Channel

Capture Settings Window

HOW TO (Usethe Menu Bar Pull-Down menus)

Choose Capture >> Captur e Settings from the menu bar for data capture setup.

Highlight Waveform 1. Be sure the Rate for Channel 1is Standard. If not, click
on the Rate menu bar and select Standard.

In the Sample Rates box, press the down arrow titled Standard Rate.
Scroll down and press 1,000.

In the Storage Allocation box, press the units pull-down box and select Seconds.
(Other choices are minutes, hours and Ksamples).

Press the value box to open the Seconds Window.

Pressthe digits“1” and “0”. Press OK.

In the Storage Allocation box, press the Percent Pre-trigger box. Press the digits
“2" and “0". Press OK. Be surethere is a green check mark next to the
Percent Pre-Trigger.

Below the waveform selection window, in yellow text, the Record Duration should
be 10 seconds, the Pre-Trigger Duration should be 2 seconds.

In the Automation Box, be sure that both the Auto Re-Arm & Auto Archive are not
checked. At this point, your Capture Settings Window should look like the image
above.

PressOK.
This completes the second part of the exercise, Data Capture Settings.
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[11. Trigger Setup and Data Capture:

In the Data Capture Settings section above, aten second capture was set up with two seconds of pre-trigger (data before
the trigger). Inthis section, atrigger level of 8 Voltswill be set with arising slope so that as the signal rises and reaches
8 Volts, the data capture will be triggered.

ACTION
Enter Trigger Settings

Select level triggering

Set to trigger when 9 Voltsis
applied

Save and exit trigger setup

Arm for capture

Input battery voltage into
Channel #1

Trigger Setup Menu

Amplitude Leval OR

-Trigger
Events

Manual

External

Trigger Settings Menu

HOW TO (Usethe Menu Bar Pull-Down menus)
Choose Setup >> Trigger Settings from the menu bar to enter Trigger Settings.

Press Amplitude Level OR to highlight in yellow. Be sureall other trigger types ( other OR types,
AND types, manual, etc. ) are not highlighted. If so, press them to deselect.

o

Waveform 2
Waveform 3
Waveform 4
Waveform §
Waveform 6
Waveform 7
Waveform 8

585585

Trigger Level
Press the Trigger Level button (15" button in the row of buttons at the bottom).
In the Trigger Level window, highlight Waveform 1.
PressLevel. Then press New Value. Pressthe digit “8". Press OK.
Press Slope. Then press Rise.
Press OR. Then pressYes.
Press OK at the lower right hand corner of the menu.
You have just set the trigger to be asserted when the signal input into channel one
rises past 8 Volts.

Press OK. Press OK.

Choose Capture >> Arm from the menu bar to arm for capture.
The Capture Progress window pops up indicating status.

A trigger should be produced and the capture continues to the end. While capturing, you should have
seen the waveform for Channel #1 increase from the bottom of the channel to near the top of its
channel.

This completes the third part of the exercise, Trigger Setup and Data Capture.

9



V. Data Review:
Data capture records can be reviewed on the color display. VCR-like control buttons allow for convenient scrolling
through the data. Cursors can be placed on the data for measurements. During review, the timebase can be expanded or
compressed to give appropriate detail of the signal. From the display, part of or all the data can be saved.

Load Data Capture File

DBXDATA4

J

Filename Creation Time: Size

05/23/2005 15:65:53 198 KB Directory
DBXDATAT 08/25/2004 09:37:48 108995 KB Directary
DBXDATAZ2 08/25/2004 09:32:23 9389 KB Directory
DBXDATA3 08/25/2004 09:32:21 9795 KB Directory

List of data capture records for review

ACTION HOW TO (Usethe Menu Bar Pull-Down menus)
Enter Review Mode Choose Configuration >> Review from the menu bar to enter the Review Maode.
Select file to be reviewed Click on the top-most file name to highlight the capture. Press OK.
- S
—=21d
- [=]
== D]
- N
o S
.|
. ﬁ
| B
e —

Data Capture Review of 9 Volt battery data capture

Show entire capture Choose Display >> Show All File from the menu bar to show entire capture.

Note: If theentirefileis already shown, a check mark will be next to Show All File in the Display
pull-down menu.

Show the trigger point Choose Display >> Show Trigger Line from the menu bar to show the trigger point.
Note: Thetrigger lineis shown asa red vertical line. If the trigger line is already shown, a check
mark will be next to Show Trigger Line in the Display pull-down menu. Be sure the trigger lineis
shown on the display.

Continued.........
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Using cursors to make measurements

Show only Channel 1 Choose View >> 1 Channel from the menu bar to show only Channel 1.
Expand the time base Choose Display >> Compression from the menu bar. Pressthedigit “1”.

Press OK.
Scroll through the data Use VCR buttons. Y ou can jog forward or backwards through the data. Y ou can

stop at any points of interest. Experiment scrolling forwards and backwards.

Continue to scroll and stop the display when you have the trigger point (red
vertical line) in the middle of the display.

Cursors Pressthe A cursor icon. Slide the cursor just to the left of the trigger point.
Press the B cursor icon. Slide the cursor just to the right of the trigger point.

EEEE M0 NS

Time measurements Choose View >> Status Text Format >> Relative Time from the menu bar.
using cursors Observe the time values shown at the bottom.

Amplitude measurements Choose View >> Show Channel I nformation from the menu bar.

using cursors Move Cursor B by dliding it to the right. As you move the cursor, observe the

change in values in the Channel Information window.
Remove the cursors Press the A cursor button and B cursor button to remove them.

Show entire capture Choose Display >> Show All File from the menu bar to show entire capture.
This compl etes the sample exercise.

9. POWERING DOWN

When the power switch is set to the of f position or if AC power islost or removed, the Dash 8Xe/ Dash 8X begins the power down
sequence. Thisisindicated by the green LED next to the power switch that will be on while the power down sequence occurs. Note
that the LED will either be a solid green or it may flicker. Itisvery important not to turn the power switch back to the on position
during the power down stage. The Dash 8Xe/ Dash 8X must be allowed to complete the power down sequence to insure proper
operation.

This completes the Dash 8Xe / Dash 8X Quick Start Guide. Please note that the Dash 8Xe / Dash 8X has much more capability than
presented in this guide. Please see the Operations Manual for details. Should you require additional assistance, you can contact our
Technical Support Department toll-free at 800-343-4039 or by e-mail: techserv@astromed.com

11



